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GENERAL OVERVIEW OF DATA SET

A Land Use Inventory for Dane County is collected every ten years. The 2000 land use inventory is the first seamless GIS data layer for all of Dane County that includes all cities, villages and towns.  The land use was primarily interpreted from orthophotos in rural areas and field surveys in developed areas.  Land use interpretations are not based on tax or assessment records. Land use for the City of Madison was not collected in this inventory, but was obtained from the City of Madison Panning Unit, as of 1/2000, in order to create a seamless data set.

DATA DEVELOPMENT METHODOLOGY

This section describes the procedures for interpreting and digitizing the 2000 land use inventory for Dane County.

Data Format:


ARC/INFO Poly and Point Coverages; ArcView Poly and Point Shape Files:

A polygon and point coverage will be created for each township tile (including cities and villages). The polygon coverage contains the land use/cover.  The point coverage is locations of residential buildings, including farms.  Shape files are then created from the coverages for distribution.

Data Source:


Digital Orthophotos: 6” and 1’ resolution  (DCLIO, 4/00)




Digital Parcel Mapping: (DCLIO, 12/00)




Land Use Survey Work Maps: (DCRPC, 7/00)




1990 Detailed Land Use Inventory: (DCRPC, 4/90)




Dane County Employers (Claritas Inc., 1999)

Naming Convention: 

Polygon: LU2PxxD9 where xx is DCLIO town abbreviation

Point: LU2TxxD9 where xx is DCLIO town abbreviation

Attribute Definitions:

Polygon:

LU2PxxD9_ (ArcInfo Reserved Item)

LU2PxxD9_ID (ArcInfo Reserved Item)




LUCODE (width-4, type-numeric, decimal - 0); primary land use code




LUCODE2 (width-4, type-numeric, decimal - 0); additional land use code

LUCODE3 (width-4, type-numeric, decimal - 0); additional land use code

MCD2K (width-30, type-character); municipality*




Point:

LU2PxxD9_ (ArcInfo Reserved Item)

LU2PxxD9_ID (ArcInfo Reserved Item)




LUCODE (width-4, type-numeric, decimal - 0); land use code




UNITS (width-4, type-numeric, decimal - 0); number of residential units




MCD2K (width-30, type-character); municipality*

* These items are not manually coded, they will be added through a spatial union at the end of the project

Projection/Coordinate System Parameters:  

Dane County Coordinate System, NAD 83-91PROJECTION 

LAMBERT /* Local projection is Lambert conformal conic

UNITS FEET /* US survey foot

PARAMETERS 6378407.621 6357022.9351403 /*(1) semi-major and minor axis in meters

42 54 30 /*Local projection South Latitude in DMS

43 13 50 /*Local projection North latitude in DMS

-89 25 20 /*Local projection longitude of origin in DMS

41 45 00 /*Local projection latitude of origin in DMS

247193.2944 /* Local projection false easting in meters

0.00 /* Local projection false northing in meters

Tolerances:

Dangle = 3.0’, 

Fuzzy = 0.100’,
Weed = 10.0’




Node Snap = 15.0’      Arc Snap = 15.0’         Grain = 15.0’




Edit = 50.0’

Characteristics of the Data: 

There are several guidelines to follow when interpreting the land use survey maps and orthophotos.
Residential:  In general, residential use is digitized for the entire parcel, especially in villages, cities, and rural subdivisions. Where parcels are very large (more than 5 acres – 217,800 square feet) or where portions are clearly devoted to some other use, such as agriculture, only the portion devoted to residential use is digitized as such. This area is subjectively determined by the digitizer, but should include the house and surrounding area identified by visual features such as lawns, gardens, fences, etc. (Bubul, 1980).

All residential and farm buildings also have a point digitized (codes: 111, 113, 115, 129, 140, 142, 116, 190, 92, 93).

A mobile home with more than one unit indicates this is a mobile home park (code: 142). The area (polygon) feature should be coded 142 and a single point digitized for the park.

Farm Unit:  These are locations where there is also a residence; the area (polygon) is digitized as Agriculture (91) and the point as a Farm Unit (116). Where farm-related buildings occur isolated from the residence, the polygon is digitized as Agriculture (91) and a point is digitized as a farm building (93). For tabulation purposes, a standard residential acreage of 2.5 will be used for each farm unit (116) point digitized (Miller, 1990).

Industrial:  Generally, entire parcels are digitized, including parking lots, storage areas, etc. Where large parcels are owned by an industry but only partially used for industrial purposes, only that portion is digitized industrial.  Extractive uses are outlined from the orthophoto; all such areas, including inactive ones, are coded extractive.

Transportation:  All rights-of-way are digitized and coded as such (45, 41, 47)

Communications and Utilities:  These are primarily small parcels and are entirely digitized. Isolated water towers, etc. are outlined from photos. Transmission and gas lines are not digitized.

Commercial-Retail and Services:  Only the portion of the lot or parcel used for this purpose is so digitized. Parking lots and storage areas are included within the associated commercial code. Split uses (commercial/residential) are coded with an additional attribute (LUCODEx) - any residential use is coded as the first use. If the parcel is a shopping center, it is coded as a shopping center (9) unless lot splits already exist for each individual store.

Institutional/Governmental: Only the portion used for this purpose is so digitized. That includes schools, which may be digitized as partially vacant or farmed if the school owns tracts of land, but has only developed part of them for the school grounds. The balance may be rented to a farmer and thus the use is agriculture.

Recreational:  Generally, includes an entire parcel, such as parks and camps. Designation as recreation supersedes any specific characteristics of the land, such as woodland or wetland. However, undeveloped parkland, which is publicly owned but remains in agriculture or some other use, is coded according to that other use. The recreational use must be actively occurring for the land to be digitized as recreation. In addition, this designation implies a degree of development for recreational purposes; large public areas such as hunting grounds and wildlife areas are not digitized as recreation, even though they may be used for some recreational purposes.

Woodlands:  These areas are delineated from the orthophotos. As a rule of thumb, they are digitized only where they occur as a passive land cover and are not actively used for any particular purpose. This includes woodlots on farms, on institutional land unrelated to the woods (such as a correctional institution) and on other public land not developed for active outdoor recreation. Where the woods are actively used, as for recreation in parks, the land is digitized as recreation and woodlands are not identified.  If a lot in a platted subdivision is undeveloped and largely wooded, it is coded as woodland (99). 

Other Open Land: This is a residual category, signifying land that is not developed or waiting to be developed (i.e., platted lands), not farmed, and not wooded. It consists largely of wetlands and other unclassified land, which is not considered vacant, because it is for the most part un-developable and not suitable for cropland or pasture.

Vacant Land:  This is land which is probably developable but which is currently unused. This category (98) is used mostly within incorporated areas or subdivisions; land in unincorporated areas, outside of rural subdivisions, is normally classified agriculture or other open land.

Commercial Forest:  This includes Christmas tree farms, tree nurseries, or other wooded areas determined to be commercial.

Farm Buildings:  Where buildings appear in agricultural areas on the orthophotos, but are removed from farm units, they are digitized as a point feature (93). Some specialty farms (i.e., mink, poultry), which consist of groups of buildings, are digitized as a farm building with the appropriate numerical code (92). The parcel feature for these is digitized as Agriculture (91).

Crop and Pasture:  All remaining, unclassed land area is crop and pasture land. 

Open Water:  The orthophoto is used as a source to delineate these features where there is a major deviation from the parcel mapping.  The open water code is 10.

Digitizing Procedure:

Two data sets will be developed for each township: a polygon coverage and a point coverage.  The polygon coverage will be created by modifying a parcel mapping coverage and adding the appropriate attributes.  The point coverage will be created using only the tic and boundary information from the parcel coverage.

Point coverage creation, editing, and attributing will be done using a customized ArcView 3.2a GUI.  Polygon creation, editing will be done with Arc/Info Workstation; attributing is done using the customized ArcView 3.2a GUI.

Digitizing the point coverage:

Create a point coverage with the appropriate name (LU2TxxD9) and store it in the LandUse2000 workspace.  Add the items LUCODE and UNITS.

Begin digitizing all the points for the township using the 2000 orthophoto as a backdrop to the parcel mapping at a scale of 1”=200’ (1:2400).  Place the point at the approximate center of the building/location.

Use the ArcView GUI to add the LUCODE to each point.  Wait until all the points have LUCODE coded before coding the UNITS.  Code the UNITS to the following LUCODE as listed:


0 units: 92, 93

1 unit: 111, 116, 140, 190

2 units: 113

Units for remaining codes need to be interpreted from the survey maps or orthophoto (115, 129, 142)

Use a spatial union on the point coverage with the 2000 parcels to populate the MCD2K attribute.

Digitizing the poly coverage: 

Using Arc/Info (and dropitems.aml) purge all the items, delete all labels, build, and add the LUCODE items.

Begin an edit session in ArcTools:



Open ArcTools, select Edit Tools.



Open previous edit session: Edit > Session: Open



In Edit Tools Window:




Open a coverage: File > Coverage:Open





Navigate to workspace, select cover, select feature arc




Change Symbols: Display > Drawenv:General





Set arc color to light blue.





Turn labels on and set to purple tic.





Turn nodes and dangles on.





Dismiss window.




Add back ground coverage: Display > Backenv:Image





Navigate to image and select





Check Display box, Apply, Cancel window



Set snapping environment:




Select Edit Env in Edit window.





Set vertex distance = 10 feet





Set node snap tolerance = 15 feet





Set arc snap tolerance = 15 feet





Apply





Cancel



Save edit session in Edit Tools Window (saves all previous settings)




Edit > Session: Save As





Begin digitizing:



Zoom into area in display window: Pan/Zoom > Extent



Set scale and units in Edit Tools Window: Arctools > Commands




Type “mapunits feet” and enter




Type “mapscale 4800” and enter 

Do all digitizing at this scale or larger (e.g. 1:3600)

Type “mapscale auto” to use Extent menus.




Use Edit Arcs and Nodes Window





To add arc (split polygon or add new polygon)






Click Add Arc






Click top of display window






Start arc by pressing 2 (node)







Define arc with left-mouse clicks (vertex)








Press 4 to delete last vertex.







Finish arc by pressing 2 (node) on beginning point






Stop digitizing  - press 9





To undo new arc – click oops


Build topology in Edit Tools Window:




Tools > Topology: Build





Accept defaults





Click Refresh After Build box





Apply




Check results in ArcTools Dialog window 





Build needs to be successful






If not, may need to do clean or track down errors




Save built coverage


Code land use to polygons with customized ArcView 3.1a GUI.




Open attribute table, select SHAPE field and CREATE INDEX




Use Land Use Coding tools to code the parcels.

Contact:

Dan Seidensticker

GIS Planning Specialist

Madison Area Metropolitan Planning Organization

121 South Pinckney, Suite 400

Madison, WI  53703

Telephone:  (608) 266-9119

References:

Bubul, Steve (1980). Dane County Regional Planning Commission Memo – Preparation of 

Permanent Reference Maps, August 25, 1980.

Miller, Nancy (1990). Dane County Regional Planning Commission Memo – 1990 Land Use


Survey, June 7, 1990.

LAND USE CODING SYSTEM

This section describes the land use codes used in the inventory.  This coding system was also used for the 1980 and 1990 land use inventories. It is based on the Standard Industrial Classification (SIC).
RESIDENTIAL

111 - Single Family
113 - Two Family
115 - Multiple Family
129 - Group Quarters

140 - Mobile Home 

142 - Mobile Home Park

116 - Farm Unit
190 - Seasonal Residential 

INDUSTRIAL

21 – Food and Kindred

Meat Products- Manufacturing


Dairy Products- Manufacturing


Canning and Preserving of Fruits, Vegetables and Seafoods


Grain Mill Products- Manufacturing


Bakery Products- Manufacturing


Sugar Manufacturing


Confectionery and Related Products- Manufacturing


Beverage- Manufacturing


Other Food Preparations and Kindred Products Manufacturing, N.E.C.

22 – Textile and Mill

Broad and Narrow Woven Fabrics and Other Smallwares (cotton, manmade fibers, 

silk and wool)- Manufacturing


Knit Goods- Manufacturing


Dyeing and Finishing of Textiles (except wool fabrics and knit goods)

​
Floor Coverings (rug and carpets) – Manufacturing


Yarns and Threads – Manufacturing


Other Textile Goods Manufacturing N.E.C.

23 – Apparel and Related

Men’s, Youths’, and Boys’ Clothing – Manufacturing


Women’s, Misses’, Juniors’. Girls’ Children’s and Infants’ Clothing – Manufacturing


Hats, Caps and Millinery – Manufacturing


Leather and Leather Products - Manufacturing


Fur Goods – Manufacturing


Miscellaneous Apparel and Accessories - Manufacturing


Other Fabricated Textile Products – Manufacturing

24 – Lumber and Wood Products Manufacturing

Logging Camps and Logging Contractors


Sawmills and Planning Mills

Millwork, Veneer, Plywood and Prefabricated Structural Wood Products - Manufacturing


Wooden Containers – Manufacturing

Other Lumber and Wood Products (except furniture) – Manufacturing, N.E.C.

25 – Furniture and Fixtures Manufacturing


Household Furniture – Manufacturing



Office Furniture – Manufacturing



Public Building and Related Furniture – Manufacturing



Partitions, Shelving, Lockers and Office and Store Fixtures – Manufacturing



Other Furniture and Fixtures – Manufacturing, N.E.C.

26 – Paper and Allied Products Manufacturing


Pulp – Manufacturing



Paper (except building paper) – Manufacturing



Paperboard – Manufacturing



Paperboard Containers and Boxes – Manufacturing



Building Paper and Building Board – Manufacturing

27 – Printing, Publishing and Allied Industries


Newspapers: Publishing, Publishing and Printing



Periodicals: Publishing, Publishing and Printing



Books: Publishing, Publishing and Printing



Commercial Printing



Manifold Business Forms – Manufacturing



Greeting Card – Manufacturing



Bookbinding and Related Industries – Manufacturing



Printing trade Service Industries



Other Printing and Publishing, N.E.C.

28 – Chemicals and Allied Products Manufacturing


Industrial Inorganic and Organic Chemicals – Manufacturing

Plastics Materials and Synthetic Resins, Synthetic Rubber, Synthetic and Other Manmade Fibers (except glass) – Manufacturing

Drug – Manufacturing

Soap, Detergents and Cleaning Preparations, Perfumes, Cosmetics and Other Toilet Preparations – Manufacturing

Paints, Varnishes, Lacquers, Enamels and Allied Products – Manufacturing

Agricultural Chemicals – Manufacturing

29 – Petroleum Refining and Related Industries


Petroleum Refining



Paving and Roofing Materials – Manufacturing



Other Petroleum Refining and Related Industries, N.E.C.

31 – Rubber and Miscellaneous Plastic Products Manufacturing


Tires and Inner Tubes – Manufacturing



Rubber Footwear – Manufacturing Reclaiming Rubber



Miscellaneous Plastic Products – Manufacturing



Reclaiming Rubber



Miscellaneous Plastic Products – Manufacturing



Other Fabricated Rubber Products – Manufacturing, N.E.C.

32 – Stone, Clay and Glass Products Manufacturing


Flat Glass – Manufacturing



Glass and Glassware (pressed or blown) – Manufacturing



Cement (hydraulic) – Manufacturing



Structural Clay Products – Manufacturing



Pottery and Related Products – Manufacturing



Concrete, Gypsum and Plaster Products – Manufacturing



Cut Stone and Stone Products – Manufacturing



Abrasive, Asbestos and Miscellaneous Nonmetallic Mineral Products – Manufacturing

33 – Primary Metal Industries


Blast Furnaces, Steel Works and the Rolling and finishing of Ferrous Metals



Iron and Steel Foundries



Primary Smelting and Refining of Nonferrous Metals

Secondary Smelting and Refining of Nonferrous Metals and Alloys

Rolling, Drawing and Extruding of Nonferrous Metals

Nonferrous Foundries

Other Primary Metal Industries, N.E.C.

34 – Fabricated Metal Products Manufacturing
Ordnance and Accessories

Machinery (except electrical) – Manufacturing

Electrical Machinery, Equipment and Supplies – Manufacturing

Transportation Equipment – Manufacturing

Other Fabricated Metal Products – Manufacturing, N.E.C.

35 – Scientific Instruments
Engineering, Laboratory and Scientific and Research Instruments and Associated Equipment -        
Manufacturing

Instruments for Measuring, Controlling and Indicating Physical Characteristics – Manufacturing

Optical Instruments and Lenses – Manufacturing

Surgical, Medical and Dental Instruments and Supplies - Manufacturing

Opthalmic Goods - Manufacturing

Photographic Equipment and Supplies - Manufacturing

Watches, Clocks, Clockwork Operated Devices and Parts – Manufacturing

36 – Miscellaneous Industrial, N.E.C.
Jewelry, Silverware and Plated Ware – Manufacturing

Musical Instruments and Parts – Manufacturing

Toys, Amusement, Sporting and Athletic Goods – Manufacturing

Pens, Pencils and Other Office and Artists’ Materials – Manufacturing

Costume Jewelry, costume Novelties, Buttons and Miscellaneous Notions(except precious metals) – Manufacturing

Tobacco – Manufacturing

Motion Picture Production

Warehouse and Storage

Other Miscellaneous Manufacturing, N.E.C.

38 – Wholesale Trade

Motor Vehicles and Automotive Equipment – Wholesale

Auto Salvage

Waste, Scrap Salvage

Drugs, Chemicals and allied Products – Wholesale

Dry Goods and Apparel – Wholesale

Groceries and related Products – Wholesale

Farm Products (raw materials) – Wholesale

Electrical Goods – Wholesale

Hardware, Plumbing, Heating Equipment and Supplies – Wholesale

Machinery, Equipment and Supplies – Wholesale

Oil Tanks

Farm Elevator – Storage

Other Wholesale Trade, N.E.C.


39 – Extractive
Sand and Gravel Quarrying

Mining

Other Resource Extraction

TRANSPORTATION

41– Railroad, Transit
Railroad Transportation Facilities

42 – Motor Vehicle Transportation
Bus Transportation (including terminals)

Motor Freight Transportation

County Garages

43 – Aircraft Transportation
Airports and Flying Fields

Aircraft Loading, Launching and Repair

44 – Marine Craft Transportation
Marine Vehicle Loading, Launching and Repair, Including Locks, Artificial Channels, Water 
Access Sites, Structures Over Water

45 – Street, Road, Highway Right of Way
46 – Automobile Parking
Lot or Ramp for the Sole Purpose of automobile Parking

47 – Non-Motorized Transportation
Pedestrian, Bicycle Trails and Facilities

COMMUNICATION/UTILITIES

Generating/Processing

481 – Electric - Including Power Plants, Offices, Telephone Radio, TV Studios

482 – Gas

483 – Water

Transmission - Towers, Pipes, Wires or Other Methods of Diffusing or Collecting

484 – Electric – Including Telephone, Radio, TV Transmission Towers and Facilities

485 – Gas
486 – Water

Waste Processing/Disposal/Recycling

487 – Sewage

488 – Solid Waste

489 – Other Communication/Utilities, N.E.C.

COMMERCIAL – RETAIL SALES


   9 – Shopping Center
52 – Building Materials, Hardware and Farm Equipment
Lumber and Other Building Materials

Heating and Plumbing Equipment 

Paint, Glass and Wall Paper

Electrical Supplies

Hardware and Farm Equipment

53 – General Merchandise
Department Stores

Mail Order Houses

Limited Price Variety Stores

Merchandise Vending Machine Operators

Direct Selling Organizations

Other Retail Trade - General Merchandise, N.E.C.

531 – General Repair and Maintenance
Auto Repair and Services

Electronic and Appliance Repair

Other Repair (except apparel, which are Personal Services)

 54 – Food
Groceries (with or without meat)

Meats and Fish

Fruit and Vegetables

Candy, Nut and Confectionery

Bakeries

Other Retail Trade – Food, N.E.C.

 55 – Transportation Related
551 – Motor Vehicles

552 – Tires, Batteries and Accessories

553 – Gasoline Service Stations

559 – Other Retail Trade - Automotive, Marine Craft, Aircraft and Access, N.E.C.

56 – Apparel and Accessories
Men’s and Boys’ Clothing and Furnishings

Women’s Ready To Wear

Women’s Accessories and Specialties

Children’s and Infants’ wear

Family clothing

Shoes 

Custom Tailoring

Furriers and Fur Apparel

Other Retail Trade – Apparel and Accessories, N.E.C.

 57 – Furniture, Home Furnishings and Equipment


Furniture, Home Furnishings and Equipment

Household Appliances

Radios, Televisions and Music Supplies

 58 – Eating and Drinking

Eating and Drinking Places

 59 – Other

Drug and Proprietary


Liquor

Antiques and Secondhand Merchandise

Book and Stationery

Sporting Goods and Bicycles

Farm and Garden Supplies

Jewelry

Fuel and Ice

Other Retail Trade, N.E.C.

 COMMERCIAL – RETAIL SERVICES

 61 – Finance, Insurance and Real Estate


Banking and Bank-Related Functions


Credit Services (other than banks)


Security and Commodity Brokers, Dealers, Exchanges and Services


Insurance Carriers, Agents, Brokers and Services

Real Estate and Related Services

Holding and Investment Services

Other Finance, Insurance and Real Estate Services, N.E.C.

 62 – Personal Services

Laundering, Dry Cleaning and Dyeing

Photographic Services (including commercial)

Beauty and Barber Services

Funeral and Crematory Services

Apparel Repair, Alteration and Cleaning Pickup Services, Shoe Repair Services

Day care

Other Personal Services, N.E.C.

 63 – Business Services


Advertising Services


Consumer and Mercantile Credit Reporting Services, Adjustment and Collection Services


Duplicating Mailing and Stenographic Services


Dwelling and Other Building Services


News Syndicate Services


Employment Services


Other Business Services, N.E.C.

 65 – Professional Services

Physicians’ Services


Dental Services


Hospital Services


Medical Laboratory Services


Dental Laboratory Services


Sanitariums, convalescent and Rest Home Services


Medical Clinics – Out-Patient Services


Other Medical and Health Services, N.E.C.


Legal Services


Engineering and Architectural Services


Accounting Services


Other Professional Services, N.E.C.

 66 – Contract Construction Services

General Contract Construction Services


Special Construction Trade Services


Contracting Services 

 67 – Transient Lodging

Hotels, Motels

 68 – Amusement

Motion Pictures Theaters


Drive-In Movies


Fairgrounds


Miniature Golf (not golf course)


Enclosed Participatory Sports (i.e. indoor tennis, gymnasium) 

 69 – Miscellaneous Services

Charitable Organizations, Day Care Centers


Other Services,  N.E.C.

INSTITUTIONAL / GOVERNMENT

 71 – Education

Nursery School


Elementary, Junior High, Senior High


Universities, Junior Colleges, Business Colleges, etc.


Museums and Art Galleries


Libraries

 72 – Health


Nursing Home


Hospitals


Clinics


Long-Term Health Care Homes

73 - Administrative

Executive, Legislative and Judicial Functions

Post Offices, Courthouses, Town\Village Halls (unless primarily for assembly)

 74 – Safety

Police-Related Facilities


Fire Stations

 75 – Assembly

Churches


Sports Stadiums (arenas and field houses)


Race Tacks


Exhibition Halls and Auditoriums


Membership Organization (i.e., masons)

 76 – Cemeteries
 79 – Institutional/Government, N.E.C.

Correctional Institutions


Military Bases and Reservations


Other, N.E.C.

OUTDOOR RECREATION

 81 – Cultural Activities and Nature Exhibits

Zoos


Arboreta


Nature walks


Historic and Archeological Sites

 82 – Camp and Picnic

Public or Private Areas Solely Designed for Camping and Picnicking

 83 – Other Land-Based Outdoor Recreation

Multiple Use Parks


Playgrounds/Playlots

Golf Courses

Playing Fields and Courts

Skiing and Skating Areas

Amusement Parks

Riding Stables

 84 – Other Water-Based Outdoor Recreation

Swimming Beaches


Pools

AGRICULTURE/SILVICULTURE

 91 – Cropland/Pasture
 92 – Animal Husbandry (including buildings)

Intensive Raising and Housing of Animals, Including Fish and Fowl


Feedlots, Related Buildings

 93- Farm Building/Accessories

Sheds, Silos, Other Farm Structures

94 – Commercial Forest

Cultivation of Trees for Timber and Other Forest Products


Christmas Trees, Nursing Production Areas (not retail sales areas)


Forestry Services

 95 – Fishing and Related
 96 – Other Agriculture, N.E.C.

Other Agricultural Related Activities

 97 – Other Open or Vacant Land

Undeveloped, Unplatted Land Not in Agricultural Production, Not Wooded

(This is a “residual” category used for all undeveloped land not otherwise classified.)

 98 – Vacant, Unused Land

Vacant Lots in Developed Areas or Subdivisions

 99 – Woodlands (non-commercial forest)
999 – Under Construction
 10 – Open Water
SUGGESTED CODE CLASSIFICATION AND COLOR SCHEME FOR 

GENERAL LAND USE MAPS

An ArcView 3.2 legend (.avl), ArcGIS 8.1 layer (.lyr) and ArcGIS 8.1 style (.style) with the following properties are also available.

Undeveloped, Non-agriculture (97)

R 152

G 204

B 49

Under Construction (999)

R 215

G 194

B 158

Water Body (10)

R 115

G 223

B 255

Commercial Forest (94)

R 61

G 179

B 114

Woodland (99)

R 0

G 99

B 0

Outdoor Recreation (81 - 84)

R 0

G 255

B 0

Agriculture (91 - 93, 95 - 96)

R 194

G 254

B 194

Cemeteries (76)

R 16

G 124

B 130

Extractive (39)

R 204

G 145

B 158

Vacant (98)

R 245

G 222

B 179

Institutional / Governmental (71 - 75, 79)

R  0

G 112

B 255

Transportation (41 - 47)

R 178

G 178

B 178

Communication / Utilities (481 - 489)

R 160

G 102

B 50

Industrial (21 - 38)

R 180

G 82

B 205

Commercial - Retail Services (61 - 69)

R 205

G 85

B 85

Commercial - Retail Sales (9, 52 - 59, 531 - 559)

R 255

G 0

B 0

Multi-Family (115, 129)

R 238

G 118

B 0

Two Family (113)

R 255

G 166

B 0

Single Family (111, 140, 142, 190)

R 255

G 255

B 0

